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Preface

Intended Audience
Welcome to Release 11i of the Oracle Sales Offline User Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Sales Offline

■ Oracle Field Sales (formerly known as Oracle Sales Online)

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle 
Sales Offline.

■ Chapter 1 provides an introduction to Oracle Sales Offline.

■ Chapter 2 provides information on creating and updating a task.

■ Chapter 3 provides information on creating and updating leads.

■ Chapter 4 provides information on creating and updating opportunities.

■ Chapter 5 provides information on creating and updating quotes.
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■ Chapter 6 provides information on creating and updating forecasts.

■ Chapter 7 provides information on creating and updating customers.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Sales Offline.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.
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Related Documentation
Oracle Sales Offline shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Sales Offline.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Sales Offline (and 
any other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Sales Offline Implementation Guide
This guide provides how to implement and manage Oracle Sales Offline. 

Oracle Field Sales User’s Guide
This guide explains Oracle Field Sales, an HTML-based applications that provides 
sales managers, sales representatives, and sales executives with assistance in 
managing their business opportunities, customer, forecasting, incentive 
compensation, partners, and quotes. 

Oracle Quoting User Guide
This guide explains how to use Oracle Quoting to create and manage customer 
quotes across all sales and interaction channels. Oracle Quoting is used to propose 
product solutions and perform negotiations, while enforcing consistent business 
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rules throughout the sales cycle. Users can publish and print quotes, and eventually 
convert quotes to orders. 

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.
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Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Sales Offline implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Sales Offline 
and reach full productivity quickly. You have a choice of educational environments. 
You can attend courses offered by Oracle University at any one of our many 
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Education Centers, you can arrange for our trainers to teach at your facility, or you 
can use Oracle Learning Network (OLN), Oracle University's online education 
utility. In addition, Oracle training professionals can tailor standard courses or 
develop custom courses to meet your needs. For example, you may want to use 
your organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Sales Offline working 
for you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.
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Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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1

Introduction to Oracle Sales Offline

This chapter discusses the key features and functionality of Oracle Sales Offline. 
Sections in this chapter include:

■ Section 1.1, "Overview"

■ Section 1.2, "Sales Offline Prerequisites"

■ Section 1.3, "Oracle Sales Offline Key Features"

■ Section 1.4, "Oracle Sales Offline Integrations"

■ Section 1.5, "Accessing Oracle Sales Offline"

■ Section 1.6, "Navigating within Oracle Sales Offline"

■ Section 1.7, "Setting Synchronization Preferences"

■ Section 1.8, "Synchronizing Data"

■ Section 1.9, "Conflict Resolution"

■ Section 1.10, "Timing Log"

■ Section 1.11, "Version Identification in Oracle Sales Offline"

■ Section 1.12, "Status Bar Messages"

1.1 Overview
Oracle Sales Offline gives you the information you need to remotely manage your 
sales efforts, and offers sales organizations the functionality required in an interface 
that is both familiar and effective. Leveraging the capabilities of desktop 
applications, Oracle has designed a template that provides sales organizations a 
way to manage sales information without the need to install additional software. 
The template is downloaded from Oracle Field Sales and provides 
ffline 1-1



Sales Offline Prerequisites
upload/download data capabilities. Oracle Sales Offline provides you with the 
ability to view and edit sales information, while your support organization does not 
have to support any additional technical software on laptops.

To manage and close deals successfully, sales teams often cross group boundaries, 
territories and even company lines. Oracle Sales Offline works with Oracle Field 
Sales and Oracle Telesales to create a virtual sales team that enables the sharing of 
opportunities, contacts, notes, and other customer information between sales team 
members. Opportunities can be automatically or manually assigned to sales 
members. Sales representatives are able to see information from partners about their 
accounts as they prepare for on site meetings. Oracle's sales automation modules 
complement each other and provide the solution for team selling in a dynamic 
environment. 

Oracle Sales Offline imports and exports (synchronizes) information from an Oracle 
enterprise database, and enables you to view and update your sales information 
remotely via your laptop computer. You can add, view and edit customers, 
opportunities, leads, quotes, and forecasts from your laptop, saving the changes for 
subsequent upload. 

You can optimize your selling time in the field by having key customer information 
readily available. This enhances your relationships with customers and promotes 
company profitability. Oracle Sales Offline integrates with the Oracle Sales 
applications, and is designed to maximize sales effectiveness in the mobile 
environment. Oracle Sales Offline is part of the Oracle E-Business Suite, an 
integrated set of applications that are engineered to work together.

1.2 Sales Offline Prerequisites
The prerequisites for Oracle Sales Offline are:

Oracle Applications
■ Oracle Field Sales, minimum version required is 11.5.7 (also known as Oracle 

Sales Online)

■ Oracle Quoting, minimum version required is 11.5.7 (if you will be using offline 
quoting)

■ Oracle Quoting patch for seeding status

■ Oracle Web Applications Desktop Integrator
1-2 Oracle Sales Offline User Guide                        



Oracle Sales Offline Key Features
Desktop Requirements
■ Windows 98/NT/2000/XP operating system

■ Microsoft Excel 2000, XP

■ Licensed copy of WinZip

Desktop Recommendations
■ 500 mHz or higher processor

■ 256 mb RAM or higher

1.3 Oracle Sales Offline Key Features
Oracle Sales Offline includes the following features:

■ Lead Management

■ Opportunity Management

■ Sales Forecasting

■ Offline Quoting

■ Task Management

■ Flexfield Support

■ Home Tab - New Items and Conflict Resolution

■ Incremental Synchronization

■ Synchronization Preferences Filters

■ Upload MyChanges Synchronization

■ Multilanguage Support (MLS)

■ Common Product Catalog

Lead Management
You can manage leads and qualify them into sales opportunities in Oracle Sales 
Offline. Leads can be prioritized so that you can target activities on hot leads first. 
Oracle Sales Offline gives you access to lead information such as notes history, and 
key contacts. All changes to the lead can be synchronized back to the enterprise 
database. Also, you can perform the lead to opportunity business flow in Sales 
Offline.
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Oracle Sales Offline Key Features
Opportunity Management
You can manage opportunities remotely through the sales cycle. Oracle Sales Offline 
gives you access to opportunity activities and statuses, notes history, key contacts 
and sales credits. You can create and update the opportunity information by adding 
new notes, and changing the opportunity status. Access to this information and the 
ability to update it enables sales organizations to sell more effectively. Sales team 
members can share information about call activity, major issues, and account 
strategy. All changes to the opportunity can be synchronized back to the enterprise 
database. Also, you can perform the opportunity to quote business flow in Sales 
Offline.

Sales Forecasting
Oracle Sales Offline enables you to build forecasts constructed from opportunities. 
Sales forecasts can be updated on the road, and forecast commitments can be 
synchronized back to the enterprise database to be viewed by sales managers.

Offline Quoting
Oracle Sales Offline supports mobile quoting functionality. The quoting 
functionality enables you to maintain and develop customer quotes. You can view 
detailed quote information, such as customer account information, contact details, 
and ship-to and bill-to information. Products can be added, removed, and priced 
using offline quoting. Manual price adjustments can be performed at the product 
line level. All changes to the quote can be synchronized back to the enterprise 
database. You can generate quotes to view and edit at a customer site. 

Task Management
Sales Offline supports task management features. You can download tasks that are 
assigned to you, or that you own. These tasks can be viewed and edited in Sales 
Offline, and you also have the ability to create new tasks. Tasks can be stand-alone, 
or associated to an Oracle business object. You have the ability to display tasks for a 
particular day or date range in Sales Offline using the Daily Task summary form.   

Flexfield Support
Sales Offline supports customer defined flexfields, where applicable. Flexfields 
established in the online sales applications can be downloaded for use in Sales 
Offline. You can add, view, and edit data captured in these flexfields, and have the 
data synchronized to and from the online sales applications. 
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Oracle Sales Offline Key Features
Home Tab - New Items and Conflict Resolution
The Home Tab of Oracle Sales Offline is the first window you see in the application, 
and lists newly added or changed records during the last synchronization. Initially, 
the Home tab will not list any records. New or changed items are listed as the result 
of subsequent synchronizations. Records are listed in the various tables, depending 
on the source of the record.

The Conflict Resolution subtab is available in the Home Tab. The conflict resolution 
sheet displays conflicted records that occurred during synchronization, and 
provides a side-by-side comparison of the local client record and the associated 
server record. You can reapply or discard the conflict records directly through 
Oracle Sales Offline.

Incremental Synchronization
Oracle Sales Offline supports incremental synchronization for uploading and 
downloading sales data. After the initial installation, only the records that have 
been changed or added in Oracle Sales Offline are uploaded during 
synchronization, and only the records that have been added or changed in the 
online applications are downloaded.

Synchronization Preferences Filters
The Synchronization Preferences allows you to selectively download sales data and 
filter data based on Oracle business objects such as, organizations, leads and 
opportunities. These download options can be saved and edited. 

Upload MyChanges Synchronization
Oracle Sales Offline supports the Upload MyChanges synchronization for 
uploading sales data. If this option is selected, only the records that have been 
changed or added in Oracle Sales Offline are uploaded during synchronization. 
Upload exceptions for an Upload MyChanges synchronization are flexfield 
information, profiles, and quote addresses. Records that have been added or 
changed in the online applications will not be downloaded.

Multilanguage Support (MLS)
Oracle Sales Offline is MLS compliant. Multilanguage Support includes:

■ Language Data Handling: Support for characters from any language as data in 
the application.

■ Locale Formatting: Support for local formats for date, time, number, address, 
and name. 
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Oracle Sales Offline Integrations
■ Search and Sort: Support for locale-specific searching and sorting.

Common Product Catalog
Oracle Sales Offline supports the common product catalog, which is used by all 
Sales applications. In the past, product categories were limited to interest type, 
primary codes, and secondary codes. Using the common product catalog, multiple 
levels of product categories are possible based on implementation needs. Product 
catalog security is inherited from the security set in Oracle Field Sales. 

The common product catalog is part of Oracle Product Lifecycle Management and 
manages product hierarchy. Your product catalog is set up in Oracle Product 
Lifecycle Management. A hierarchical catalog called Product is seeded for use by 
Sales and Marketing. You can either use this seeded catalog or create a new product 
hierarchical catalog with Product Categories. See the Oracle Product Lifecycle 
Management Administrators Guide for details.

1.4 Oracle Sales Offline Integrations
Oracle Sales Offline integrates with:

■ Oracle Field Sales: Oracle Field Sales is an application designed for field sales 
representatives, sales managers, and executives. This application provides a 
complete set of tools that enables sales teams to manage the sales cycle from 
beginning to end. 

■ Oracle Quoting: Oracle Quoting is used to propose product solutions and 
perform negotiations, while enforcing consistent business rules throughout the 
sales cycle. Users can publish and print quotes, and eventually convert quotes 
to orders. This integration applies only if offline quoting is used in Oracle Sales 
Offline.

1.5 Accessing Oracle Sales Offline
Oracle Sales Offline is available from the Mobile tab in Field Sales, in the form of a 
compressed file.

Reference
Oracle Sales Offline Implementation Guide

Login
Log in to Oracle Applications to access Field Sales.
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Accessing Oracle Sales Offline
Responsibility
Sales Online Administrator

Navigation
Mobile > Download Sales Offline Template 

Steps
If you are a first-time-user, you must download Oracle Sales Offline from Oracle 
Field Sales before proceeding.

To download Oracle Sales Offline:

1. Log into Oracle Field Sales.

2. Click the Mobile tab. 

3. Create a new folder in your directory.

4. Download Oracle Sales Offline by clicking the Download Sales Offline Template 
link. 

5. Navigate to the downloaded file SalesOffline.zip in your directory. 

6. Unzip the file into your folder.

7. Run Oracle Sales Offline by double-clicking on SalesOffline.xls.   

8. Enable macros when prompted. If Oracle Sales Offline fails to open when you 
choose to enable the macros, check to ensure that the macros security is set to 
the medium or low level. You can do this by navigating to Tools > Macro > 
Security in Excel 2000. 

9. Click the Sync icon.

10. Enter the requested user information and then click Sync. The synchronization 
preferences will display the first time you Sync.

11. Enter the download criteria by choosing the Territory Driven Download, Sales 
Team Driven Download, or Forecast Driven Download. 

You can filter your data using the Sync preference filters associated with the 
downloads. See Setting Synchronization Preferences for details. These 
preferences can be saved for use in future synchronizations. 

Note:  Not all synchronization preferences filters are applicable to 
the Territory Driven Download. 
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Accessing Oracle Sales Offline
These are the Sync preference filters which are applicable to Territory Driven 
and Sales Team Driven downloads:

■ Lead Preferences - can be filtered by Status, Channel, Lead Rank, Budget 
Status, Time Frame, or Number of Records

■ Opportunity Preferences - can be filtered by Status, Sales Stage, Sales 
Channel, or Win Probability (from/to)

■ Quote Preferences - can be filtered by Inventory Category Set (Default 
Category Set, or the Sales and Marketing Category Set), Inventory Category, 
or Price List

You must select items (from the Default Category Set, the Sales and 
Marketing Category Set, or the Price List) for download. You can select 
items from multiple categories. Multiple items can be selected by 
highlighting a row and using the Ctrl or Shift functions.

■ Forecast Preferences - can be filtered by Period Type, Category, Start Period 
and End Period, or Credit Type

■ Customer Preferences - can be filtered by Customer Category, or Country

1.5.1 Territory Driven Download
The Territory Driven download provides additional functionality to that provided 
by the Sales Team Driven download by enabling you to limit the downloaded 
address and contact data to that pertaining to your sales territory. This is of benefit 
in that the user is able to download a smaller quantity of data, which is more 
relevant to their day to day sales activities. Sales territories are established using 
Territory Manager. Manual Territory Location assignment can also be performed in 
Oracle Field Sales.

The Territory Driven Download accounts for only the address-specific qualifiers, 
such as postal code. It does not take into account territory qualifiers, such as named 
accounts. If you use the Oracle Territory Manager assignment process, the territory 
address qualifiers must be established before this synchronization option can be 
used effectively. You can also manually assign a sales user to a certain Oracle 
business object. Manual assignments will also be synchronized by Oracle Sales 
Offline using the Territory Driven Download.

Only addresses associated to your territory are available under an Organization or 
Person. You may not be able to download or view all addresses associated to an 
Organization or Person. 
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This is how the Territory Driven downloads affect Oracle business objects available 
in Oracle Sales Offline:

Organization and Persons: The Territory Driven Download will download only 
Customers, which have an address that resides within a sales representatives 
established sales territory via an established address qualifier. The Territory Driven 
Download will download only Contacts related to an Organization, which have an 
address that resides within a sales representatives established sales territory. 

Opportunity: If a Oracle Sales Offline user is on the sales team (automatically 
assigned via territory or manually assigned) for an Opportunity, the Opportunity is 
synchronized to Oracle Sales Offline. 

Lead: If a Oracle Sales Offline user is on the sales team (automatically assigned via 
territory or manually assigned) for a Lead, the Lead is synchronized to Oracle Sales 
Offline. 

The Territory Driven Download does not affect the Task or Quote synchronization 
method. If you are on the sales team of a Quote (regardless of Territory 
information), the Quote is synchronized to Oracle Sales Offline. If you own or are 
assigned a Task, the Task is synchronized to Oracle Sales Offline. 

1.5.2 Sales Team Driven Download
The Sales Team Driven download will result in records based on your sales 
team access. If you are on the sales team of an Oracle business object (for 
example, organization, lead, or opportunity) these records are downloaded to 
Oracle Sales Offline. 

Note: Only Opportunity contacts which reside in the Oracle Sales 
Offline users territory are downloaded with the Opportunity. 
Contacts, associated to the Opportunity, that do not have addresses 
associated with the Oracle Sales Offline users territory will not get 
downloaded or viewed in Oracle Sales Offline. 

Note:  Only Lead contacts which reside in the Oracle Sales Offline 
users established territory are downloaded with the Lead. Contacts, 
associated to the Lead, that do not have addresses associated with 
the Oracle Sales Offline users territory will not get downloaded or 
viewed in Oracle Sales Offline. 
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1.5.3 Forecast Driven Download
The Forecast Driven download of data is based on the opportunities that are 
open within the forecast range selected. Customer organizations and contacts 
that are associated with the opportunities are downloaded. 

1.6 Navigating within Oracle Sales Offline
In Oracle Sales Offline, tabs indicate the first layer of information and subtabs show 
further details. Links enable you to access detailed information about specific items.

The following table describes navigation features and fields:

1.7 Setting Synchronization Preferences
Oracle Sales Offline enables you to select preferences for synchronization. These 
preferences apply to the data downloaded from Oracle Field Sales. During the 
initial synchronization, Oracle Sales Offline will by default perform a full download 
of necessary data. Using preferences to select subsets of data to download can 

Table 1–1 Navigation in Oracle Sales Offline 

Navigation Feature Description

Tab Enables you to navigate among the areas of 
functionality in the application.

Subtab Enables you to access further functionality under a 
tab.

Link or hyperlink Enables you to navigate to further levels of detail 
under the subtab.

Asterisks Designate required fields. These fields have a 
white background. Fields with a white background 
and no asterisk are optional. Fields with a grey 
background are read-only. 

Column headings Enables you to sort rows of information. Clicking 
on a column heading will sort rows in ascending or 
descending order based on the information in the 
selected column.

Go button Enables searches for a list of values. 

Ctrl F Enables you to search for a specific value.
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contribute to improved application performance.   You can modify these preferences 
after making your initial choices.

Steps
1. In Oracle Sales Offline, click the Profile icon.

2. Make your synchronization selection.

3. Click Save to save changes or Sync to start the synchronization process (which 
will save changes on completion).

1.8 Synchronizing Data
The Oracle Sales Offline synchronization process uploads changes or additions to 
the server and downloads changed or added records back to Oracle Sales Offline on 
your laptop. You do not have to log into Oracle Field Sales to upload and download 
data. The synchronization function handles this process within Oracle Sales Offline. 
See Setting Synchronization Preferences for details on changing data 
synchronization preferences for your data downloads.

Steps
To synchronize data:

1. In Oracle Sales Offline, click the Sync icon.

2. The Sync Login window appears. Enter your user name and password. 

Upload MyChanges - Selecting this checkbox allows you to upload only data 
added or modified in Oracle Sales Offline. It is recommended that you perform 
a full synchronization after downloading a new Oracle Sales Offline template, 
not an Upload MyChanges synchronization.

The Upload MyChanges synchronization differs from the incremental or full 
synchronization processes in that there are no downloads of additions or 
changes to server data. The Upload MyChanges synchronization is only 
available if you have modified or created records. The Upload MyChanges 
checkbox is disabled if you have made no changes or another synchronization is 
process. 

3. Click OK. The Sync Console appears. A status bar shows the progress of the 
synchronization. While the synchronization is in progress, you can:
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■ Go Offline - Click to go offline while synchronization is in progress. 

Go Offline enables you to use Oracle Sales Offline in a read-only (locked) mode 
while synchronization halts in the background. No changes that you make 
while Oracle Sales Offline is in locked mode are saved. Data synchronization 
must complete before you can create, modify, or save data in Oracle Sales 
Offline. Go Offline is not available during some parts of the synchronization. 
For example, you cannot choose Go Offline when the synchronization engine is 
downloading data. 

If you click the Sync button, or attempt to save data while the synchronization 
is offline in locked mode, you will receive this message:

Sync and Save disabled while in locked mode.

The buttons on the tabs (for example, Task or Lead) are not disabled 
(greyed out) while Oracle Sales Offline is in locked mode. However the 
functionality associated with these buttons is disabled.

To view the progress of the synchronization while in locked mode, close the 
worksheet, and then reopen it. When you reopen it, you will receive this 
message:

Do you want to complete the unfinished sync?

and have these choices:

– Yes - continues the synchronization. You will have to provide a login 
password. The Sync Console will appear and display the 
synchronization status bar.

– No - enables you to remain in the offline (locked) mode

■ Cancel Sync - Click to cancel the synchronization that is in progress. This 
button is functional at the beginning of the synchronization. As the 
synchronization progresses, you eventually will not be able to cancel, and 
this button is disabled. The Cancel button is disabled when the 
synchronization process is writing to the enterprise database, to protect the 
integrity of the database.

Note: To disable the saving of your Sync Preferences, navigate to 
Oracle > Go Offline Autosave, and disable the autosave. 
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■ Show or Hide Details - Click Show to expand the Sync Console and show 
synchronization processing messages. These messages are similar to a log 
file. Click Hide to hide the processing messages. 

4. You will receive a message at the end of the synchronization process informing 
you that the synchronization was successful or if there were conflict errors. 

a. If you receive conflict errors, navigate to the Home tab and click the 
Conflict Resolution subtab to resolve the conflicts in the Conflict Resolution 
screens (see Section 1.9, "Conflict Resolution").

b. If you receive a server not found and not available error, contact your 
administrator for assistance.

5. At the successful end of the synchronization, you will see a message that the 
synchronization is complete, and another message recommending that you save 
your data. Click Yes to save or click No to cancel the save.

1.9 Conflict Resolution
Using a remote application that synchronizes information with an enterprise 
database can result in data conflicts. Conflict resolution is critical to using a remote 
application successfully, and it is important that up-to-date and accurate 
information is written to the enterprise database. 

It is important to note that the server record will always override your Oracle Sales 
Offline client record. If the same server and client record has been changed in 
between synchronization processes, a conflict will occur, and the server record will 
override your client record. The conflict can be resolved in the Home tab, using the 
Conflict Resolution subtab.

During a full and incremental synchronization, all conflicts associated with a 
particular user are downloaded. In order to minimize the data downloaded, during 
an Upload MyChanges synchronization, only conflicts created during a particular 
Upload MyChanges synchronization are retrieved. While you can reapply or 
discard conflicts after performing an Upload MyChanges synchronization, you 
cannot view the online record associated with that conflict. Error messages are 
available to indicate the cause of the conflict. 

Note: It is strongly recommended that you save your data after 
the synchronization completes.
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Steps
To resolve conflicts between the Oracle Field Sales database and Oracle Sales 
Offline:

1. Open Oracle Sales Offline.

2. Click the Conflict Resolution subtab in the Home tab.

3. In the Conflict Resolution screen, you will see tables listing the conflicts that 
occurred during synchronization. 

4. Click the link to see details of the conflicted record and make the necessary 
updates before deciding to apply the changes or discard them.

On the left side of the form is your local Oracle Sales Offline record. On the 
right side of the form is the Oracle Field Sales server record. The fields that 
caused the conflict are shown in red. 

If you choose Reapply, the Oracle Sales Offline record will override the Oracle 
Field Sales record. You must perform a synchronization for your record to be 
applied to the database. If you choose Discard, your Oracle Sales Offline 
changes will not be applied to the Oracle Field Sales server. If you discard the 
conflicts you do not need to perform a synchronization. 

5. From the main Conflict Resolution screen you can select groups of conflicted 
records to Reapply or Discard. Select the checkbox by the record(s) you want to 
reapply or discard. If you want to reapply your changes to the server, click 
Reapply. If you want to discard the conflict, click Discard.

1.9.1 Non-Validated Records (Rejected Records)
You can view rejected records in Oracle Sales Offline, as well as a message 
indicating why the record was rejected. Any record that is created in Oracle Sales 
Offline and does not pass the online validation rules during the 
upload-synchronization process is captured in a Non-Validated record table in the 
Home tab of Oracle Sales Offline. The non-validated records table displays each 
record that did not pass the server validation rules, the reason why the record did 
not get applied to the server, and allows you to rectify (Reapply, Discard or Cancel) 
the non-validated record.    

The table contains two columns, Non-Validated Records and Sync Time. The 
Non-Validated Records column contains the record name with hyperlink. The Sync 
Time column contains the server date stamp for the non-validated record's 
synchronization.
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The most recent non-validated records are listed at the beginning of the table. If a 
non-validated record is a header record, then any accompanying line records are 
grouped together in the table, with the header record listed above the line records.

If the rejected records are related (for example, an opportunity header item and the 
related opportunity lines), then these records are grouped together in the 
non-validated table. If a header record results in a conflict, it is the first item in the 
grouped records, followed by the related line items.

Both rejected header and lines records are listed. Click the identifying text for the 
rejected record and activate the hyperlink that will generate the conflict resolution 
details form. You can read the resulting error message, determine the details of the 
conflict record, and then choose what action to take (either Reapply or Discard) for 
the non-validated conflict record.

1.9.1.1  Failed Quote Header and Line Records
Quote records with conflicts are grouped in the list of Non-Validated Records on the 
Home page of Oracle Sales Offline. Quote headers that fail validation are 
hyperlinked to the Conflict Resolution form, with no associated quote lines listed. 
Quote headers that pass validation, but have associated quote lines that fail will be 
listed with those failed lines hyperlinked to the Conflict Resolution form. 

If the quote header contains the conflict, the quote will not be included in the list of 
Quote Names shown on the Quote tab until the conflict is resolved. Quotes with 
conflicts in the quote lines will be listed in the Quote Names list on the Quote tab.

The Oracle Sales Offline Error status appears in the Status field on the General tab 
of the Quote Details window when a quote has a conflict in the quote lines that 
must be resolved in Oracle Sales Offline. Until the conflict in the quote lines is 
resolved, the quote is in a read-only status, meaning that no part of it can be 

Note: Quote header flexfields are not supported in this release.

Note: Oracle Field Sales users cannot transform a quote into an 
order when one or more lines in the quote are in a conflict state. 
The exception to this is the conflict status Stale Records.
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updated, with the exception of Tasks. All buttons are disabled at this point, with the 
exception of Cancel. 

In Oracle Field Sales, you can update the Tasks and Notes for this quote, but it will 
otherwise be in the read-only state until the conflict in the quote lines is resolved. 

If you choose to Reapply a header record
This message will appear:

Are you sure you wish to reapply this record? If you choose to reapply this 
non-validated record, you must perform a synchronization operation for the 
record to be applied to the online server applications. This record, and all its 
associated line items, if applicable, will be applied to the online server 
applications.

Click OK or CANCEL. If you choose Cancel, there is no further action.

If you clicked OK, the header record is removed from the non-validated table, a row 
is inserted into the appropriate summary sheet (depending on the source of the 
record), and the record is queued for synchronization.

If the header record has related line records, the associated records will also be 
removed from the non-validated table.

If you choose to Reapply a line record
This message will appear:

In order to reapply this record you must also reapply the header record. Please 
select, and reapply the header record from the Non-Validated records table.

Click OK.

The line record will remain in the non-validated table and will only be removed 
when the header record is reapplied or discarded.

If you user choose to Discard a header record
This message will appear:

Note: There is no status transition during the quote approval 
process. Quotes with statuses such as contract required, approval 
pending, contract pending, and order submitted will retain the 
current status. However, you may still have Sales Offline errors, so 
verify the status of the quote. 
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Are you sure you wish to discard this record? If you choose to discard this 
non-validated record, this record and all its associated line items, if applicable, 
will be removed from Oracle Sales Offline. This record will NOT be 
synchronized to the online server applications, and will be removed from Oracle 
Sales Offline.

Click OK or CANCEL.

If you clicked OK, the header record is removed from the non-validated table, no 
row is inserted into any summary sheet and the record is removed from Oracle 
Sales Offline.

If the header record contains related records, then the line records will also be 
removed from the non-validated table and the related data is removed.

If you choose to Discard a line record
This message will appear:

In order to discard this line level record you must first discard the header record. 
Please select, and discard the header record from the Non-Validated Records 
table. If you choose to do so, both the header record and all its associated line 
records is removed from Sales Offline. 

Click OK.

1.10 Timing Log
The timing log provides timing statistics for these events:

■ Opening a file

■ Synchronizing data

■ Saving a file

These statistics enable administrators to analyze Oracle Sales Offline’s performance 
and identify issues that may arise when a large volume of records are processed.

Note: For quotes, users have the ability to discard a conflicted line 
without first having to discard the header record. For example if a 
quote is created with twenty line items and one of the line items 
fails validation, in the Non-Validated Records section, a link to the 
failed line item will be provided. You may choose to update the line 
item and re-apply or discard the line item completely.
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Enabling Detailed Logging

Steps
By default, the timing log is always enabled. You can choose to enable detailed 
logging.

1. Open SalesOffline.xls.

2. Select Oracle > Logging > Detailed 

3. You can also choose Reset to restart the logging, so that the existing log file is 
deleted and a new one begun during your current session. 

4. Exit the template.

5. Reopen the template.

The next time you synchronize your data, Oracle Sales Offline will write 
detailed logging information about events to the log file. The log file is located 
in the logs directory in the folder containing Oracle Sales Offline, and is called 
aslclient.log.  

Logging for a Full or Incremental Synchronization

Steps
Unless the Upload MyChanges checkbox is selected, the first synchronization of the 
Oracle Sales Offline data is a full synchronization. Subsequent synchronizations are 
incremental.

1. Open SalesOffline.xls.

2. Perform a full synchronization by selecting the Sync button and providing login 
information. 

3. Exit the template. 

4. View the resulting log file in the logs directory in your Oracle Sales Offline 
folder.

Note: Each time you open the Oracle Sales Offline template, the 
log file is copied to a.bak file, and the .log file is cleared. To view the 
timing log, you must look at the log in the logs directory before you 
open the template.
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1.11 Version Identification in Oracle Sales Offline
You can provide support personnel with a unique version number that identifies 
the implemented client version of Oracle Sales Offline by navigating to 
Oracle > About Sales Offline. This enables you to identify the version of the client in 
use when you report an Oracle Sales Offline problem. 

1.12 Status Bar Messages
Status bar messages for phases that relate to the processes of file open, file close, file 
save, and synchronization in Oracle Sales Offline are displayed in the Microsoft 
Excel status bar.
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Managing Tasks

Sections in this chapter include:

■ Section 2.1, "Creating a Task"

■ Section 2.2, "Updating a Task"

■ Section 2.3, "Accessing the Daily Task Summary"

Use the Task tab to view, create, and edit tasks. Tasks are your day-to-day activities 
related to customers, leads, and other sales-cycle events. Also, the Calendar button 
enables you to access a Daily Task summary, which lists your tasks occurring 
between specified start and end dates. 

The Task tab displays all of your tasks, or tasks that have been assigned to you.

2.1 Creating a Task
To create a task:

Steps
1. In the Task tab, click Create.

2. In the Task Details tab, select a task type.

3. Enter a task name.

4. Describe the task.

5. Set the priority for the task.

6. Select a status for the task.

Note:  Oracle Sales Offline does not support recurring tasks. 
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7. Specify if the task should be private or requires notification.

8. Select a category for the task.

9. Select start and end dates and times for the task, and specify if it is planned, 
scheduled, or actual.

10. Select the customer type, if needed, and search for the customer’s name.

11. Click the References tab to add optional reference information to the task.

You can remove any reference rows by selecting the associated remove 
checkbox and clicking Save or Apply. 

12. Click the Assignments tab to add optional assignees to a task.

You can add additional persons to assign the task. In the Assignments tab of the 
Task detail user from, click the Add an Assignment field and select the person 
to assign the task from the menu. Click Add.

Note: The task number is generated after synchronization.   

Note: The References tab in Oracle Sales Offline will not 
automatically populate reference rows. On synchronization, the 
newly created task and the reference rows will automatically be 
created in the online sales application, and the appropriate 
reference rows are synchronized to the Oracle Sales Offline task. 
You may add additional rows in Oracle Sales Offline if you choose 
to do so.

For example, if you select a contact, Brenda Johnson@ Business 
World, the references for the contact Brenda Johnson and 
organization Business World are automatically generated by the 
online applications after you synchronize. 
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You may also remove an assignment rows (except the owner row) by selecting 
the associated remove checkbox and clicking Save or Apply.

13. Click the Contacts tab to add optional contacts to a task. In the Contacts tab of 
the Create Task user window, place in the contacts name you wish to add, click 
Go, and select the contact from the list of values. In order to select the primary 
contact for a Task, select the Primary radio button next to a contact. 

You may remove any contact rows by selecting the associated remove checkbox 
and clicking Save or Apply. 

14. Click the Notes tab to create a note for the task.

15. Click Create to create the task. 

2.2 Updating a Task
To update a task:

Steps
1. In the Task tab, click the task name.

2. Complete any updates. 

3. Click Apply to apply changes as you continue to make changes, or click Save 
when you have completed your changes.

2.3 Accessing the Daily Task Summary
Click Calendar to access a Daily Task Summary. This summary displays all of the 
tasks that have a start date of a specified day, or within a date range.

Note: The Assignments tab in Oracle Sales Offline will not 
automatically populate any assignment rows. With the next 
synchronization, the assignment’s owner row for the new task is 
automatically created in the online sales application, and the owner 
row is synchronized to the Oracle Sales Offline task record. The 
owner of the task is the Oracle Sales Offline user who created the 
task. You may add additional assignee rows in Oracle Sales Offline. 
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Managing Leads

Sections in this chapter include:

■ Section 3.1, "Creating a Lead"

■ Section 3.2, "Updating a Lead"

■ Section 3.3, "Lead to Opportunity Business Flow"

Use the Lead tab to view and manage leads. Leads capture the initial contact with 
potential customers, gathering information to indicate to a sales organization 
whether or not there is customer interest. When a lead is entered, it can be ranked 
and assigned to the appropriate sales resource.

Once enough information has been gathered, a lead can be qualified by a sales 
representative.

Leads can be generated through various sources:

■ Marketing campaigns and trade shows can generate leads that can be imported 
into the system through the Lead Import process.

■ TeleSales agents record lead information from phone calls.

■ Field sales representatives record lead information from the field into a sales 
application.

Note: There is Flexfield support for Header and Purchase Item 
level flexfields for leads. If Flexfield functionality has been 
implemented for a lead, the Flexfield name, field, and Flexfield 
button are displayed. 
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3.1 Creating a Lead
To create a lead:

Steps
1. In the Lead tab, click Create.

Some fields will automatically populate based on data and profile preferences 
established in your Online Sales applications.

2. Select the Organization or Person radio button to list the organization name or 
the person’s name and address in the search results.

Enter a customer name or search for a customer. Enter the customer name in the 
customer field, or enter part of a customer name and click Go. The list of 
customers will display. You can select a customer from this list, or search for 
another customer. 

Click Create Customer to create a customer.

Select an address by clicking Add or Change next to the address field. A list of 
customer addresses displays in the Select an Address window. Click the radio 
button next to the address and click Select.

3. Enter a lead name.

4. Select a primary contact for the lead, or create a new contact by clicking New.

5. Select the contact role.

6. Specify whether the lead is qualified or urgent.

7. Add the project name associated with this lead.

8. Select the status of the lead.

9. Select the lead rank.

10. Select a channel for the lead.

11. Select a response channel.

12. Select the time frame for the lead.

13. Select a budget status.

14. Enter the budget amount.

15. Select currency type.

16. Enter the source name for the lead, or search for the name by clicking Go.
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17. Enter the offer name, or search for the name by clicking Go.

18. Enter any flexfield information, if applicable. 

19. Click the Purchase Items tab to enter purchase item information.

20. Click the Notes tab to enter notes. 

21. Click Save to save the lead.

3.2 Updating a Lead
To update a lead:

Steps
1. In the Lead tab, click the name of the lead.

2. Complete any updates.

3. Click the Opportunities tab to view any opportunities generated by the lead.

4. Click Save when you have completed your changes. 

3.3 Lead to Opportunity Business Flow
To create a opportunity from an lead:

In the Lead Details window, click Lead to Opportunity. 

This information will flow from the lead to the new opportunity into a new 
Opportunity Detail window:

■ Lead Name (Opportunity name)

■ Customer Name

■ Primary Contact

■ Project

■ Budget

■ Currency

■ Source (header level)

■ Offer (header level)

■ Address
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■ Lead Purchase Items (including quantity, amount, source, and offer)

■ Sales Team

■ Contacts
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Managing Opportunities

Sections in this chapter include:

■ Section 4.1, "Creating an Opportunity"

■ Section 4.2, "Updating an Opportunity"

■ Section 4.3, "Opportunity to Quote Business Flow"

An opportunity is a potential sale. This process begins with the initial customer 
contact and ends when the sales representative makes or loses the sale.

Sales representatives can manage existing opportunities, assigned to them manually 
or automatically through Territory Assignment, or they can enter new 
opportunities. 

By default, the sales representative who created the opportunity has full access to 
the opportunity. Full access to the opportunity means that the sales representative 
who created the opportunity can add other sales team members, assign sales 
credits, and rate the likelihood that the opportunity will succeed.

4.1 Creating an Opportunity
To create an opportunity:

Steps
1. In the Opportunity tab, click Create.

Note: There is Flexfield support for Header and Purchase Item 
levels for opportunities. If Flexfield functionality has been 
implemented for an opportunity, the Flexfield name, field, and 
Flexfield button display. 
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2. Select the Organization or Person radio button to list the organization name or 
the person’s name and address in the search results.

Enter a customer name or search for a customer. Enter the customer name in the 
Select a Customer field, or enter part of a customer name and click Go. The list 
of customers will display. You can select a customer from this list, or search for 
another customer. 

Click Create Customer to create a customer.

Select an address by clicking Add or Change next to the address field. A list of 
customer addresses displays in the Select an Address window. Click the radio 
button next to the address and click Select.

3. Enter an opportunity name.

4. Select a primary contact for the opportunity, or create a new contact by clicking 
New.

5. Select the contact role.

6. Enter the project name.

7. Select the status of the opportunity. 

8. Select the sales channel.

9. Select the methodology associated with the opportunity. 

10. Select the sales stage for the opportunity.

11. Select the win probability.

12. Enter the budget amount.

13. Enter the close date for the opportunity.

14. Specify the currency type.

15. Enter the source name for the opportunity, or search for the name by clicking 
Go.

16. Enter the offer name, or search for the name by clicking Go.

17. Click the Purchase Items tab to enter purchase item information.

18. Click the Notes tab to enter notes. 

19. Click Apply to commit changes and calculate values. You can modify values 
and then click Apply to recalculate values.

20. Click Save to save the opportunity.
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4.2 Updating an Opportunity
To update an opportunity:

Steps
1. In the Opportunity tab, click the name of the opportunity.

2. Complete any updates. 

3. Click Apply to commit changes and calculate values. You can modify values 
and then click Apply to recalculate values dynamically.

4. Click Save when you have completed your changes.

4.3 Opportunity to Quote Business Flow
To create a quote from an opportunity:

1. In the Opportunity Details window, click Create Quote to flow the opportunity 
information into a new quote. A new quote can be created based on information 
that flows from an existing opportunity. Only purchase item rows with a 
specified inventory item numbers (along with it’s associated quantity) are 
carried over to the new quote.

This information will flow from the opportunity to the new quote into a new 
Create Quote window:

■ Opportunity Name (flows to the Quote Name field)

■ Customer Name

■ Contact Name

■ Sales Channel

■ Opportunity Purchase Items (if they have specific inventory items on the 
purchase item line)

■ Sales Team

■ Address

2. Click Apply.
                                                                 Managing Opportunities 4-3



Opportunity to Quote Business Flow
4-4 Oracle Sales Offline User Guide                         



                                                           Managing Q
5

Managing Quotes

Sections in this chapter include:

■ Section 5.1, "Creating a Quote"

■ Section 5.2, "Updating a Quote"

■ Section 5.3, "Quote Approvals"

■ Section 5.4, "Place Order"

A quote is the communication of pricing and discounts for a particular sale. When 
the customer is ready to order a particular product they are notified of this available 
pricing and discount information through a quote. 

You must select specific items from the Profile Sync Preferences Quote tab to be 
used in quoting. Only those items downloaded to Oracle Sales Offline can be used 
to add new products to the quote.

5.1 Creating a Quote
To create a quote:

Steps
1. In the Quote tab, click Create.

2. Enter a quote name.

Note: There is Flexfield support for the Quote Header and Line 
levels. If Flexfield functionality has been implemented for a quote, 
the Flexfield name, field, and Flexfield button will display. 
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3. Select the Addresses or Contacts radio button to list the address or the contact 
information in the search results.

Enter a Customer name or search for a customer. Enter a keyword to search on, 
or the first three characters of a keyword and click Go. The list of customers will 
display. Select a customer from this list, or search for another customer. 

4. Enter the contact name. Enter the contact name in the contact fields and click 
Go. The list of contacts will display. Select a contact, or search for another 
contact. 

5. Enter the expiration date for the quote.

6. Select the primary salesperson.

7. Select the sales channel.

8. Select the order type.

9. Select the associated agreement.

10. Select the currency type.

11. Select a price list.

12. Enter any flexfield information, if applicable

13. Click Apply to display additional tabs.

14. Click the Lines tab to add product lines, or to add a service to a product. Click 
Add New Product to search and select products for the quote. 

If you want to add a service item (for example, Warranty) to an existing product 
line, highlight the specific line by clicking the radio button associated with the 
product line, click Add Services, and search or select a service item to be 
attached to the product line. You will only be able to add service item lines for 
product lines are serviceable items.

15. Click the Addresses tab to add shipping and billing addresses, and manage 
payment terms. These addresses will default depending on the customer you 
entered when creating the quote. You must specify payment terms.

16. Click the Sales Team tab to add new members to the sales team.

17. Click the Sales Credits tab to give credits for the appropriate sales 
representative.

18. Click Apply to commit changes and calculate values. Modify values and then 
click Apply to recalculate values dynamically.
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19. Click Save to save the quote.

5.2 Updating a Quote
To update a quote:

Steps
1. In the Quote tab, click the name of the quote.

2. Click Apply to commit changes and calculate values. Modify values and then 
click Apply to recalculate values.

3. Click Save.

5.3 Quote Approvals
If you have approvals established for the Quoting application, the Initiate 
Approvals button will appear in the Approvals tab of the Quote Details window. If 

Note: If a newly created quote fails validation, or has a conflict, 
the quote's status will be changed to Sales Offline Error and moved 
to the Non-Validated record table in the Home Tab. Both Online 
and Offline users will not be allowed to update or process a quote 
(for example, submit to an order) with Sales Offline Error status. 
When the quote record is resolved and synced to the server, the 
status will return to Draft and returned to the quote tab.   See 
Section 1.9.1, "Non-Validated Records (Rejected Records)" for 
details.

Note: If an updated quote fails validation, or has a conflict, the 
quote's status will be changed to Sales Offline Error and moved to 
the Conflict Resolution subtab. Both Online and Offline users will 
not be allowed to update or process a quote (for example, submit to 
an order) with the Sales Offline Error status. You can add Tasks and 
Notes in Oracle Field Sales, and Tasks in Oracle Sales Offline while 
the quote has a status of Sales Offline Error.

 When the quote record is resolved in Oracle Sales Offline and 
synchronized to the server, the status will return to Draft and 
returned to the quote tab.   See Section 1.9, "Conflict Resolution" for 
details.
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the status transition is approved, click Initiate Approvals to initiate the approvals 
process. The Quote must be synchronized for the approvals process to begin. No 
approval rows are displayed in the Approvals tab of the Quote Details window. 

5.4 Place Order
The Place Order button will highlight on the Oracle Sales Offline, Quote Details 
window if the Place Order status transition is established in the Quoting 
application. If payment terms are not specified, the Place Order button is disabled. 

Oracle Field Sales users cannot transform a quote into an order when one or more 
lines in the quote are in a conflict state. The exception to this is the conflict status 
Stale Records.
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Managing Forecasts

Sections in this chapter include:

■ Section 6.1, "Opportunity Worksheet"

■ Section 6.2, "Product Category Worksheet"

■ Section 6.3, "Generating Forecasts"

■ Section 6.4, "Viewing and Submitting Forecasts"

Forecasting is a quantitative tool used to predict the amount of sales for a specified 
time period. Forecasting can be used by managers and sales team members to 
commit to the amount of sales that they will close by the end of the forecasting 
period. 

Use these worksheets to create forecasts:

■ Opportunity Worksheet: Opportunity-level forecasting provides a tool for sales 
representatives to use to create their own view of, and commitment to, sales 
opportunities for themselves and others on the sales team. Opportunity 
forecasting also gives sales representatives the ability to review, modify, and 
commit at a more detailed product category level. 

■ Product Category Worksheet: Forecasting at the Product Category level 
provides sales representatives access to their pipeline aggregated into product 
groupings. They can then forecast their sales at the product level by rolling up 
opportunity lines into product groupings.

6.1 Opportunity Worksheet
Opportunity Level Forecasting provides a tool for sales team members to view their 
forecasted opportunities. Worksheets are submitted with the generated forecasts 
chosen for submission. To view opportunity worksheets:
casts 6-1



Product Category Worksheet
Steps
1. From the Forecast tab, click the Opportunity subtab.

2. Select the sales group.

3. Select the period name.

4. Select one of the following options:

■ Use Previously Saved Values: If you are forecasting for the first time, the 
value is based on the Oracle Field Sales profile preferences. If you have 
saved an opportunity worksheet, those values will default.

■ Use Pipeline Default Values: This includes all deals available for 
forecasting whose close date falls within the current forecasting period. If 
you choose this option, the pipeline amounts for the period are populated 
into the worksheet. 

Edit the forecast values by highlighting the cells (Worst Case, Forecast, Best 
Case) and adding the value. The forecast numbers will reflect the opportunity 
forecast data available in Oracle Sales Offline.

5. Click Save.

6.2 Product Category Worksheet
Forecasting at Product Category level enables sales team members to view their 
pipeline aggregated into product groupings. Worksheets are submitted with the 
generated forecasts chosen for submission.

6.2.1 Viewing Product Level Forecasts Using Product Category Worksheets
To view product level forecasts using product category worksheets:

Steps
1. From the Forecast tab, click the Product Category subtab.

2. Select the sales group, for which you want to forecast.

3. Select the period name.

The forecast numbers will reflect the opportunity forecast data available in 
Oracle Sales Offline.
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4. Edit the forecast values by selecting the Worst Case, Forecast, or Best Case cell 
and adding in the value.

Pipeline defaults use the following criteria:

■ Worst Case: Total Won Amount = Sum of all won opportunities

■ Forecast: Weighted pipeline = Weighted sum of open opportunity amount 
multiplied by their win probability

■ Best Case: Total sum of all open opportunities

5. Click Save.

6.3 Generating Forecasts
Under the Forecast tab, you will find the Generate Forecast subtab. Sales 
representatives can generate individual forecasts for multiple periods from this 
window. Forecasts are generated based on their current downloaded pipeline 
values. You can forecast based on the default currency. To generate forecasts:

Steps
1. From the Forecast tab, click the Generate Forecast subtab.

2. Select a sales group from the drop down list.

3. Select the from period and to period.

4. Click View.

5. Select all periods for which you want to generate forecasts by selecting the 
check box.

The forecast is now ready to be submitted when you synchronize. Only the 
most recent submission is accepted. You cannot submit more than one forecast 
per synchronization. 

6. Click Submit.

6.4 Viewing and Submitting Forecasts
To view and submit forecasts:

Steps
1. From the Forecast tab, click the Forecast subtab.
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2. Select the Sales Group.

3. Select the Period Name. The forecast numbers will reflect the opportunity 
forecast data available in Oracle Sales Offline. Edit the forecast values by 
highlighting the Best Case, Forecast, or Worst Case cell and adding in the value.

4. Click Submit. 

The forecast will now be submitted when you synchronize. Only the most 
recent submission is accepted. You can submit only one forecast per 
synchronization.
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Managing Customers

Sections in this chapter include:

■ Section 7.1, "Creating a Customer - Organization"

■ Section 7.2, "Updating a Customer - Organization"

■ Section 7.3, "Creating a Customer - Contact"

■ Section 7.4, "Updating a Customer - Contact"

■ Section 7.5, "Creating a Customer - Person"

■ Section 7.6, "Updating a Customer - Person"

The Customer tab contains three subtabs: Organization, Contact, and Persons. By 
default, the Customer tab opens to the Organization window. Click the Contact 
subtab to open the Contact window, or the Persons subtab to open the Persons 
window. A person may be a contact for an organization. An Organization may have 
one or more contacts.

7.1 Creating a Customer - Organization 
To create an organization:

Steps
1.  In the Customer tab, Organization subtab, click Create. 

2. Enter the organization name.

Note: There is Flexfield support for customers. If Flexfield 
functionality has been implemented for an organization or contact, 
the Flexfield name, field, and Flexfield button will display.
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3. Enter the phonetic pronunciation of the organization name.

4. Enter any Alias for the organization.

5. Enter the DUNS number for the organization.

6. Enter the phone number for the organization.

7. Enter the tax ID for the organization.

8. Enter the e-mail address for the organization.

9. Select the customer category.

10. Enter the business line for the organization.

11. Enter the annual revenue number for the organization.

12. Enter the total employees in the organization.

13. Select the fiscal year end for the organization.

14. Enter the years established.

15. Enter the URL for the organization’s website.

16. Enter any flexfield information, if applicable.

17. Click the Addresses tab to manage addresses for the organization.

18. Click Create Address to add a new address. Enter the required fields (an 
address type) and click Save to save the address information. 

19. Click the Notes tab to enter notes.

20. Click Save.

7.2 Updating a Customer - Organization 
To update information for an organization:

Steps
1. In the Customer tab, Organization subtab, click the name of the organization.

2. Complete any updates.

3. Click the Addresses tab to add new addresses for the person.

4. Click the Sales Team tab to add or remove sales team members.

5. Click the Notes tab to enter notes.
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6. Click the Tasks tab to review tasks.

7. Click Save.

7.3 Creating a Customer - Contact
To create a contact:

Steps
1. In the Customer tab, Contact subtab, click Create.

2. Select a Contact. You can select an existing contact from the list of contact names 
in the Contact Name menu, or specify a new Contact name by clicking New.

To create a new contact, click New. 

3. Click Save to create the new contact. The newly created contact is now available 
for you to add to an existing organization. 

4. Select Organization.

If the organization is new, click New next to the organization field to create new 
organization. 

5. Select a relationship type.

6. Enter the phone number for the contact.

7. Enter the e-mail address for the contact.

8. Enter the department of the contact and the department type.

9. Enter the job title.

10. Select the job title type for the contact.

11. Select the preferred language for the contact.

12. Specify if the contact is a decision maker or a reference.

13. Enter any flexfield information, if applicable.

14. Click Add an Address in the Addresses tab to add new addresses for the 
contact. A list of addresses associated with the organization will appear. Choose 
an address and click Select. The Add a Relationship Address window appears 
allowing you to add address types.

15. Click the Notes tab to enter notes.
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16. Click Save.

7.4 Updating a Customer - Contact
To update information for a contact:

Steps
1. In the Customer tab, Contact subtab, click a contact name.

2. Complete any updates.

3. Click the Addresses tab to add new addresses for the person.

4. Click the Classifications tab to select a classification category and a classification 
status.

5. Click the Sales Team tab to add or remove sales team members.

6. Click the Notes tab to enter notes.

7. Click the Tasks tab to review tasks.

8. Click Save.

7.5 Creating a Customer - Person
To create a person:

Steps
1. In the Customer tab, Person subtab, click Create.

2. Enter the person’s name. This includes last name, first name, preferred name, 
last and first name pronunciation, and middle name.

3. Enter any title and second title (if applicable).

4. Enter any suffix (for example, Jr.).

5. Enter date of birth for the person.

6. Select gender.

7. Select native language.

8. Enter phone number.

9. Enter e-mail address.
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10. Select a status for the person.

11. Enter any flexfield information, if applicable.

12. Click Create Address in the Addresses tab to add new addresses for the person. 
A list of addresses associated with the organization will appear. Choose an 
address and click Select. 

13. Click the Notes tab to enter notes.

14. Click Save.

7.6 Updating a Customer - Person
To update information for a person:

Steps
1. In the Customer tab, Person subtab, click a person name.

2. Enter product information. 

3. Click the Addresses tab to add new addresses for the person.

4. Click the Classifications tab to select a classification category and a classification 
status.

5. Click the Sales Team tab to add or remove sales team members.

6. Click the Notes tab to enter notes.

7. Click the Tasks tab to review tasks.

8. Click Save.
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